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WELCOME TO THE WORLD OF
LEGO® MINDSTORMS®

Congratulations on your new LEGO® MINDSTORMS® NXT robotics tool set. You
now have the power to build and program robots that do what you want!

Dream it, build it

Your MINDSTORMS NXT sef enables you to create thousands
of robotic inventions. Intelligent robots that see, hear,
speak, feel and move. Advanced robots that you can confral
with your mabile phone. Cool robots that quard your room
and do your chores. IFyou can dream if, you can build it.

Build. Program. Go!

Creating a MINDSTORMS rohaot is easy. Build the robot using

vour LEGD elements. Program it using the easy-to-use soft-
ware and watch your robot come alive. For your Arst robofic
adventure, try out the quick-build model that you can build

and program in less than 30 minutes.

Smart technologies

Your MINDSTORMS NXT set features the latest in robotic technology: an
advanced 3¢-bit programmable microcontroller; icon-based drag and drop
programming software and inferactive challenges; smart sensors and Infter-
active Servo Motors; wireless Bluetoath and USE connection. In fact all the
smart technologies you need to create your dream robot.

MINOSTORMS.com

You are now a part of the worldwide LEGO MINDSTORMS community. Log on
to MINOSTORMS.com and get more robatic challenges. Download programs,
sound effects and other cool stuff, Share your inventions and exchange tips
and tricks with other MINOSTORMS users. www MINOSTORMS.com is your new
rohotic hot spof.

Find out more
!4 In this User Guide you can learn more about the technology
T, and the many exciting Features inyour MINDSTORMS set.

Hawve fun building your own amazing robots!

The LEGO MINOSTORMS team.
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_J INTRODUCTION

BUILD. PROGRAM. GO!

. [
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Build
Build a robot. You can And building

instructions in this User Guide, in the
soffware or at www.MINOSTORMS.com.

Oryou can use your imagination fo
huild your own unique rohaot.

Program

Program your robof fo do what you
want, Use the LEGO® MINDSTORMS® NXT
Software to make a program. Download
the program to the NXT by using the
LISE cable or the wireless Bluetooth
connection.
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i

EmindsTa

Quick Start

\ Use the Quick Start kit to get your Arst

MINOSTORMS experience. In the Quick
Start kit you will And everything you
need to get off fo a great start. It will

only take you a few minutes to create
your Arst MINOSTORMS robot, test if,

and get a fun reaction.

Go!

Run the program and watch your robot

come to life.
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NXT TECHNOLOGY OVERVIEW
The NXT

The NXT is an intelligent, computer-controlled
LEGO® brick and the brain of the MINDSTORMS® robot.

"’_‘,—*i] Touch Sensor

Enables the robot to feel and react to
Its environment.

A

B

J.) Sound Sensor

& Enables the robof to hear and react fo
sound.

—
g Enables the robot fo detect lightand
color.

__,b@ Light Sensor
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& % Interactive Servo Motors

Ensure that the rohot moves with precision.

Standard port settings for sensors

and motors

To make your robot work correctly, the sensors and \
motors should be connected to specific input and out-
put ports. Here are the standard port settings:

Input ports

Port 1: Touch Sensor
Port 2: Sound Sensor
Port 3: Light Sensor

Port 4: Ultrasonic Sensor

Output ports
Port &: Motor used for an extra function

) UI'I'ra SONIC SE“SO[‘ Port B: Mator for movement
Enables the robot to see, measure Port L: Mofor for movement

distance to an object, and react to
movement.
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CONNECTING THE NXT TECHNOLOGY

Note that ALL of the hlack b-wire |
cables can be used in hoth input
and output porfs, sensors and

= g‘“ f motors. To work, sensors MUST be
e attached to the input ports [1-4
: and motors MUST be attached fo
4 the output ports [A-L].

Connecting motors
To connect a motaor to the NXT, use one of the black b-wire
cables. Attach one end of the cable to the motor and the other to

one of the NXT's output ports [A, B, or [].

Connecting sensors

To connect a sensor to the NXT, use one of the hlack B-wire
cables. Attach one end of the cable fo the sensorand the other
to one of the NXT's input ports [1, 2, 3, or 4.

Downloading and uploading
The U5B port and wireless Bluetooth connection let you download and

upload data hetween your computer and the NXT. IF your computer has
Bluetooth capability, you can download programs to the NXT without using
the U5E cable. IFyour computer does nof have Bluetooth capahility, you
must use the USH cable or install a Bluetooth USE dongle on your computer.,
NOTE: Read more about wireless Bluetooth communication on page £8.
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Connecting the NXT to a PCwith a USB cahle

A
Iy
\ ] /

Turn on the NXT.

Make sure that the

LEGO™® MINDSTORMS® NXT
Software is installed before
connecting your NXT ta your PL
|see page 38].

’m e
—a 9 i T

e ™

~ |

Lonnect the PL and the NXT with the LSE cahle.

When the PLidentifes the NXT it will automatically Analize the
installation of the LEGOD MINDSTORMS NXT Software.

The U5B connection must be made by an adult or under
supervision of an adult.

er Found Mew Hardware = jr,..' Found Mew Hardware

LEGD MINDSTORMS MxT Your new hardware is inskalled and ready to use,

Connecting the NXT to a Macintosh with a LSB cable

Make sure that the LEGO MINDSTORMS NXT Software is installed before connecting your NXT to
your Macintosh [see page 39).

Turn on your NXT.

Lonnect the LUSE cable to the NXT.

Connect the USE cable fo the Macintosh and you're ready fo go.




_ I NXT TECHNOLOGY

ABOUT THE NXT

The NXT is the brain of a MINDSTORMS® robot. It's an intelligent, USB port
computer-controlled LEGO® brick that lets a MINOSTORNMS robot come Connect a LIS cable to the USE part and down-
live and |]E'r'FII|I'I‘|‘| different nperaﬂmm. load programs fromyour computer to the NXT [or

; i : upload data from the robot to your computer|.
Please note that all text on the NXT display is in English. Yo ral e pha st Blateath e

tion for uploading and downloading.
L.

Motors ports
The NXT has three output ports for attaching e
motors. To make the motor work, the motaors !
neecd to be attached to port A B or C

Bluetooth icon
The Bluetooth icon shows the current status of

any wireless Bluetooth connections. IF there is no N
Bluetooth icon shown, Bluetooth is OFF.

¥

Bluetooth is ON butyour NXT is not visible to
other Bluetooth devices.

F

Bluetooth is ON andyour NXT isvisible to other
Eluetooth devices.

e

Bluetooth is ON andyour NXT is connected toa
Bluetooth device.

USB icon
When you connect your NXT to a computer with =
a LISE cable, a USE icon will be displayed. IFyou

discannect the USE cable, the icon will disappear. T T’

USE connected and working Ane.

-y
USE connected but not working properly.

Sensor ports L

The NXT has four input ports for attaching sen-
sars. The sensors need fo be attached to port 1,
¢, dord
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] F= B ok Heb

EHER'IJE.]@J :

T ’ Conmea  F o | Ay Progan ] 8
— L |
NxTwindow] | | € ;‘
= I o E | r.E“. ;
s JJ : ’ ﬂl =TT T o
. - ) :’ = thi . — Vou cawens HIT B
A r—— 4 | b -I'-I:::" ""“ ..51
P : i S rexT® of ourrent [
L Naming the NXT hJ eEt
You can change the name of your NXT by going to - e
the NXT window in the software. This window is — s '
accessible from the Controller. NXT names can be = e = P
at most eight characters long. =" : :
=7 - sl e
= =i
4 1 {dEl Battery level
The battery icon displays the power level of the
MXT. When battery poweris low, the hattery icon
will Flash on and off.
Technical specifications
« 372-hit ARMT microcontroller
4 [ =1 Runningicon . ! 256 Khytes FLASH, B4 Khytes RAM
when your NXT is turned on, the running icon will . B:bit AVR mice Sl
spin. IFthe running ican stops spinning, your NXT - s UL Lo
has frozen and you will need to reset it [see page * 4 Kbytes FLASH, 51¢ Byte RAM
74, Troubleshooting. « Bluetooth wireless communication [Bluetooth Class |
V.0 compliant]
B Loudspeaker . LIEInI:'I Full speed |IIIIII'I1' [1¢ |""||I|i1'a'r:5 |
Make a program with real sounds and listen to « dinput ports, b-wire cable digital platform [One port
fhem when you run the program, includes a IEC 61158 Type 4/EN 50 170 compliant
expansion port for future use|
1 output parts, b-wire cable digital platform
40 NXT buttons « 100 = b4 pixel LLO graphical display
Orange huttan: On/Enter » Loudspeaker - 8 kHz sound quality. Sound channel with
Light grey arraws: Used for moving left and right B-hit resolution and 2-16 KHz sample rate.
in the NXT menu. ) . 4
Dark grey button: Clear/bo back » Pawer source: b AA bafferies
e Turning offyour NXT -
Push the dark grey buttan repeatedly until you MeT 1= =
see the screen on the right, 3 B
Push the arange button to turn off your NXT;
push the dark grey button to go back to the main TUrm |:||:|: !

MenLl.

NXT display options

Your NXT has many ather cool features. Read
maore about them on the following pages.

11
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INSTALLING BATTERIES IN YOUR NXT

1.9V ™%
6X

Battery type
« The NXT requires b AA/LRE batteries to function properly.

« Alkaline hatteries are recommended.
« Rechargeahle batteries can be used, but the NXT's power
may be reduced, making the motors furn more slowly.

Low battery power
When hattery power is low, this icon will pop up on the
NXT's display screen.

Important information about batteries
Never use different types of hatteries together, ora
combination of old and new batteries. Always remove
the hatteries if the product is not to be used for a long
fime or if the batteries have run down. Never use
damaged hatteries. Only use hatteries of the type
recommended, or a corresponding type. Insert the
batteries so that the poles are correctly positioned.
Rechargeahble batteries must be recharged using the
correct hattery charger under the supervision of an
adult. You cannot recharge batteries while they are still
in the product, and you must never try fo do so.

Never attempt to recharge non-rechargeahble batteries,
Never short-circuit the battery holder.
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NXT MAIN MENU
My Files

The My Files submenu will let you see all of the programs you
have made on the NXT or downloaded From your computer.

Sofbware Fil es MNeT Fil es
‘IE\ Eiy
(n r
Software Rles - programs you NXT fles - programs you have
have downloaded from your made on the NXT
computer

Files will automatically be placed in the appropriate subfolders. When you
download a program including a sound Rle to your NXT, the program will be
placed under Software Ales, while the sound data will be placed under Sound
fAles. You can send fAles to other NXTs. Read more about this on page 36.

Sound Fil es

Sound Ales

13




_ NXT TECHNOLOGY

NXT Program
e

You don't need a computer fo program your robot. Using
the NXT Program submenu, you can make thousands of
different programs without your computer.

Try this simple program and see how easy if is:

Make the robot go hack and forth when its Touch Sensor is pressed.
First, the robot will move forward until the Touch Sensor is pressed,
and then it will move backwards. When its Touch 5ensor is pressed
again, the robot will move forward once again. This will continue
indefnitely until you stop the program.

Make sure that your sensors and motors are connected to the right
ports.

2. PRRR—— 3 (PR —

: |
'r-";'-‘_“* ﬂr-r

‘-1‘

o W =
‘5"8«-2' 9=

LY ; y |

Select Farward. Use the amow buttans Select Touch. Select Backward.
to move through the choices and then

press the orange button |Enter| to

make your selection.

E
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- . _—{‘_ L | 1 ll_

awl "
2y

'

—

Select Touch again. Mow select if you want the program o Mow you can run your program.
Loop. This means that the program will Simply select Run!
run again and again until you switch
off the NXT. For our little test, select
Loop.

Try these programs as well:

"IfTHAH e HAHD

“IiHkH O 3
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Try Me

The Try Me submenu lets you fest your sensors and motors

in a fun way:

Lonnect the sensors and motors to the appropriate ports on
the NXT. Impaortant: Use the standard settings for the ports as
explained on page 7.

Select a program.

When you press the orange |[Enter| button, you will get some
Fun reactions From the sensors and motors.

Explore other Try Me programs fo get some more fun sounds, to
display images and to experience different motor reactions.

You can always delete these Try Me fles again using the
Settings submenu.
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View

The View submenu lets you carry out a quick test of your
sensars and motors, observing real-time data from each
unit:

Connect the sensor or motor you would like to test o
the NXT - the View submenu will help you select the
right port or check standard settings on page 7.
Select View on the NXT's display.

T (P

E— E—=F
1 Y 1 Y |
DT oy et M TR
= / =] 4/ = /
\ gl L Ty J)
Select the icon of the sensor ar motor Select the port that the sensor or mo- The data from the sensor ar mator will
you would like to fest. You can anly get toris atfached to. appear on the display.

readings from one sensor or motor at
a time.

17
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Settings

The Settings submenu lets you adjust the NXT's settings
including its speaker volume or the Sleep mode setting.
This submenu will also let you delete programs that have

been stored in the NXT's memory.

*

dEb
(=]

oo Lol

|
(

Change volume:

Here you tan adjust the volume

of the NXT's speakers.

0

F
e

Sleep mode: You can set the NXT to furn

itself off after £, 5, 10, 30 or b0 minutes of
inactivity [time when its notinuse|. You can also
select the Never sefting so that it remains on
indefnitely [until you turn it off|. Please he aware
that the Never setting will drain your batteries more

quickly.

-

.
*

dEb
%)

bbbl

L

Delete all programs:

You are able to delete all downloaded pro-
grams in the 3 sub folders: Software fles,
NXT Rles, Sound RAles, from the Settings
submenu.
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Bluetooth
o e T

The Bluetooth submenu will let you make a wireless
connection between your NXT and other Bluetooth devices
|like other NXTs, mohile phones, and computers|. You can use
a wireless Bluetooth connection to send programs to other
NXTs, to download programs from your own computer
without using a USB cahle, and lots of ofher cool things,
such as using your mobile phone to control your robot! Read
more ahout wireless Bluetooth communications on pages ¢8.

19
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My Fil es MZT F'r-:ngram
P

MAET PI'IIIII_|I'E|IT|

Flease use pork:
1 - Touch Sensor
2 -Sound  Sensor
- Light Sensor
- brasanic

E/C - LIR motors

Forweard 5
Ncil

| |
Forward 5

o

My Files
Soupd files Softvare £l es Melfiles R W e~ S
LﬁglJ @ Fort 2: Sound Sensor
Fort 3: Light Sensor
Sound Ales Software Ales NET Ales Port 4 Lltrasonic Sensor
Port B/L: 'R motors
Eack left Turn left Turn left 2 Empt Backyvard Backward 5
H H
|<£' | “ < Il ‘ Il \
Back left Turn left Turn left £ Empty Backward Backward 5
Eack left 2 Tone 2 Tome 1 Back right Back right 2 Turn right
\-cﬂ | X \ P \ L B [~
Back left £ Tone & Tone | Back right Back right 2 Turn right
Forward Turn right 2
‘ ] @]
Forward Tum right 2
Sound Light |T|:u_||:|'||
2] O] =il
Sound Light Tauch
Cbjeck W'aic 10 Wik o aik =
FIE
|| LE] ] X &
Ohject wait 10 wWait 5 Wait 2
""' Loop ]
" General Icons: )
i File exsists File&rname:
‘ Save \ ':""E"W”te? Unkikled_ Loop
|E]\ r;;,’:? ’ 321 @:7 abe

Run Save
Send

|5§E| [ & Sending file
Sent Sending Ale

\

File exists, Overwrite?

Celete

Oelete

File name: Untitled

Main menu
L)

Main menu

‘ L‘j:? File savedw

File saver

Tm_pﬂ

Empty

F

EE

|

Stop
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Yiew

View

E-Junm

Sound db

Port 12,3, 4 A,8,C

Sound dBA
L i H

Sound B4

Ternperature F*
A;

Temperature F*

Rotation®*

Llrasonic cm Ulerasonic inch
1

Ultrasonic inch

Lltrasonic cm

H
Rotation®
—{eT

Feflecked i gh £

Reflected light

Temperature
A

Temperature [*

Mator rotations

{2

Motor rotations

Yisabilicy
& |

Visibility

Yisible
=
]

Visible

Trrvisibales

o

Ivisilile

On

Off

OfFf

‘ ‘.ﬁ.mbient light
Ligh t Sensor®

Light Sensor*

Mokor degrees
34 |

Motor degrees

Ambient light

Eluekooth

|
Bluetooth

Touch
i

Touch

Settings

2

Settings

Wl e

<]

Volume

My conkacks

My contacts

Try Mes

Try Me

Celete Files
— Tal -

Delete Ales

Deleting &l |
i |es!
Are you supe?

of |

Deleting all Ales!
Areyou sure?

Sleep
O

Sleep

Connections

ey

Con

nections

oy

F

[ " SEarchingl

Searching

| % Tarning -:nr||

Turning on

|ﬂ, Failed !]

Failed!

| %% Connecking |

Connecting

| A Connection |

Connection?

[ A Line is husv]

Line is husy
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3 TOUCH SENSOR

The Touch Sensor gives your rohot a sense of fouch.
The Touch Sensor detects when it is being pressed hy
something and when it is released again.

o~

.

o

b

Pressed

o s - v - -
( &l &Fd
| kRE'|EE15Ed | Bumped J

|

Test |

!

Suggestions for use

You can use the Touch Sensor to make your robot pick up
things: a robotic arm equipped with a Touch Sensor lets the
rohot know whether or not there is something inits arm to
grab. Oryou can use a Touch Sensor to make your robot act on
a command. For example, by pressing the Touch Sensoryou can
make your rohot walk, talk, close a door, or furn on your TV,

Test the Touch Sensor and get a fun reaction,
Connect a Touch Sensor to port 1 of your NXT and
celect the Try-Touch program in the Try Me submenu

on the NXT's display.
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f SOUND SENSOR

The Sound Sensor makes your robot hear!

The 5ound Sensor can detect both decibels |dB| and
adjusted decibels |dBA|. A decibel is a measurement of
sound pressure.

dBA: In detecting adjusted decibels, the sensitivity of )
the sensor is adapted to the sensitivity of the human

ear. In other words, these are sounds that yvour ears are )))
able to hear.

dB: In deftecting standard [unadjusted| decibels, all /
sounds are measured with equal sensitivity. Thus, these

sounds may include some that are foo high or low for the human ear to hear.

The Sound Sensor can measure sound pressure levels up to 90 dB - ahout the level

of a lawnmower. Sound pressure levels are extremely complicated, so the Sound
Sensor readings on the MINOSTORMS® NXT are displayed in percent [%]. To give some
comparative examples: 4-5% is like a silent living room. 5-10% would be the reading
you get from someone falking some distance away. 10-30 % is normal conversation
close to the sensor or music played at a normal level. And you will record readings of
30-100% from people shouting and music played at high volumes.

Test it!

Test the Sound Sensor's ahility to read
sound volume:
LConnect the Sound Sensor to the NXT.

Suggestions for use

You can use the Sound Sensor to make
a sound confrolled robot. Talk to your
robot and it will answer you hack. Llap
vour hands and the robot can pick up
things and bring them to you.

=

1 .

by

o . ‘_,-'
Select the View submenu on the Make some sounds into the Sound 3ensor and watch the readings
NAT's display. Select the Sound displayed on the NXT. Lise the sensor to read some sounds around you.
Sensor icon and the port where you How loud doyour parents speak? How loud isyour front doorhell?

have connected the sensor.

Select the Try Me submenu on the NXT's display and fest
vour Sound Sensor. You'll get a fun reaction.

23
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0
< J LIGHT SENSOR

The Light Sensor is one of the two sensors that give
your robot vision |the Ultrasonic Sensor is the other].
The Light Sensor enahles your robot to distinguish
between light and dark. It can read the light intensity
in a room and measure the light intensity of colored

surfaces.
r.. | This is what yaur eyes see.
-. This is what your rohot will see,
using the light sensar.
' -

Suggestions for use

You can use the Light Sensor to make a burglar
alarm robot: when an intruder turns on the light
in your room, the robot can react fo defend your
property. You can also use the Light Sensor to

make a line-following robot or a robot that can
/ sort things by color,

Detecting ambient [surrounding] light

Test the Light Sensor's ability fo read ambient light by
measuring the light level in different locations of the room.
For example, Arst hold the sensor against the window. Then
hold it under the table. Watch how the readings differ.

Test it!

You can test the Light Sensor in different ways:
Connect the Light Sensor to the NXT.

1 [T |
1 . i I-_-—t 1
bl =
-~ e — ‘--'I I._ _‘-"'
Select the View submenu on the Hold the Light 3ensor up to the different colors an the fest pad and see

NXT's display. Select the Light the different readings.
sensor ican and the port where you
have connected the sensar.

E

Select the Try Me submenu on the NXT's display and test your
Light Sensar. You'll get a fun reaction.
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lﬂi@ ULTRASONIC SENSOR

The Ultrasonic Sensor is the other sensor that gives
vour robot vision. The Ultrasonic Sensor enables the
robot to see and defect objects. You can also use it to
make your robot avoid ohstacles, sense and measure
distance, and defect movement.

The Ultrasonic 5ensor measures distance in
cenfimeters and in inches on the NXT. It is ahle fo
measure distances from 0 fo €55 centimeters with a
precision of +/-3 cm. "

The Ultrasonic Sensor uses the same scientific principle as bats: it measures
distance by calculating the fime it takes for a sound wave to hit an object and return
— just like an echo.

Large-sized ohjects with hard surfaces return the best readings. Objects made of

soft fabric or that are curved [like a ball] or are very thin or small can be difficult for
the sensor fo defect.

Note that two or more Ultrasonic Sensors operating in the same room may interfere
with each other's readings.

Test it!

Test the Ultrasonic Sensor's ahility fo measure distance:
Connect the Ultrasonic Sensor fo the NXT.
Select the View submenu in the NXT display.

—

Suggestions for use

You can use the Ultrasonic Sensor in
many different ways. Frogram a rohot to
sneak around the house without it
bumping into things. Or make an
advanced burglar alarm robot that reacts
fo movement as well as light. Your
Scorpion rohot “stings™ if you come to
close.

|
2

4 3 b
=

o |

I e el ) L

s g

4 Il b
=

|

Select the Ultrasonic Sensor icon Measure the distance to an object. For example, move your hand closer to

and the port where you've con- the sensor and watch the readings change.
nected the sensar.

Select the Try Me submenu on the NXT's display and test your
Ultrasonic Sensor. You'll get a fun reaction.

25
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INTERACTIVE SERVO MOTORS

The three Servo Motfors give your robot the ability
to move. If you use the Move block in the

soffware to program your motors, the fwo motors
will automatically synchronize, so that your robot
will move in a straight line.

Built-in Rotation Sensor
Each motor has a built-in Rotation Sensor. This lets

you control your robot's movements precisely. The
Rotation Sensor measures motor rotations in degrees
or full rofations [accuracy of +/- one degree|.

One rotation is equal to 360 degrees, soif you set a
motor to turn 180 degrees, its output shaft will make
half a turn.

The built-in Rotation Sensor in each
mator also lefs you sef different speeds
For your motors |by setting different
power parameters in the software|. Try
running the motors at different speeds.

Test it!

Test the built-in Rofation Sensor's ability to measure distance:
Lonnect a motor fo the NXT.
Select the View submenu in the NXT's display.

-

qmb
-

select the Motor Rotations icon. Naow attach a wheel to the maotor and measure the rotations as you roll the wheel along the floar.
Select the port where you have

ENEEEH e muir, Select the Try Me submenu on the NXT's display and test your

motors. You'll get a Fun reaction.

|
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=l 1. The motar

=) 2. Tachometer |Rotation Sensor|

=

3. Built-in gearing

27
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€3 Bluetooth’ usine sLueroot

T

Bluetooth is a technology that makes it IFyou have a mohile phone with Bluetooth
possible to send and receive data without capability, you can use it fo control your
using wires or cahles. Using Bluetooth, robot. You might even be ahle fo use it as
you can exchange programs hetween your an advanced sensor, |ike a camera sensor.
NXT and other NXTs. Oryou can establish Visit www MINOSTORMS. com/bluetooth, for
a wireless connection between your com- more information on mobile phone require-
puter and your robot and try out programs ments.

instantly — even with your robot on the
other side of the room!

0
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CONNECTING YOUR NXT TO A COMPUTER

Before you try fo sef up a wireless Bluetooth connection, make sure
that your computer has Bluetooth capahility.

IF yvour computer does not have huilt-in Bluetooth capability, you
must use a Bluetooth USB dongle. Make sure that you use the right
type of Bluetooth USE dongle. Read more about the different types of
Bluetooth USE dongles fo use af www.MINOSTORMS.com/hluetooth

£

=

Make sure that your NXT is turned on. Also Find the Controller at the lower right corner
make sure that yvou have Bluetooth set to of the work area in the software. Click on the
On and that your NXT is set to be Visible MXT window hutton [the one at the upper left]
[read how inthe Bluetooth submenu on and the NXT window will open.

the NXT on page 34]. Also make sure that
Bluetooth is installed and enabled on your
computer. See your computer's and
Bluetooth USB dongle's instruction manu-
als for details.
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Click Scan. Your computer will automatically search for
Bluetooth devices.,

Lfter a short interval, a list of availahle Bluetooth devices

will appear in the window on the computer screen. Select
the device you want to connect to and click the Connect
hutton,

When you connect to a device for the Rrst time, the Enter

Pacckey window will pop up. Enter the passkey to use with

this device [the default passkey is 1234] and click 0K,
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n
4 5.
- »

g

£ prr— ) ) Enter the passkey on your NXT and confirm the connection
= by pushing the arange [Enter] button. IFyou have chosen

-‘- the default passkey, just click the orange |Enter] button.
S— , "

Mall

\ In the NXT window, the status of your NXT has now changed
from Available to Connected. Your NXT and computer are
now connected and can share data.
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MAKING THE CONNECTION TO A MACINTOSH

+:

Make sure that your NXT is furned on. Also
make sure that you have Bluetooth set to
On and that your NXT is set to he Visible
[read how in the Bluetooth submenu on
the NXT on page 14]. Also make sure that

Bluetooth is installed and enabled on your

computer. See your computer's and
Bluetooth USB dongle's instruction manu-
als for details,

M T window

e
I

Find the Lontroller at the lower right corner
of the work area in the software. Click on the
NXT window hutton [the one at the upper left|
and the NXT window will open.

i)
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Select Bluetooth Device

To And dewices in range of your comauter, click the Search bution. Then |
ST @ Blueroorh Deesige from the list of dovicas

Dewlice Type: Al Types

|

Device Category:  All Categories

| Search |

i Add to Favorites

¢
b

( Cancel ) { Select } ﬁ

5
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Click Scan. The Bluetooth device window will pop up on the
SCreen.

A list of Bluetooth devices will appear in the Select
Bluetooth Device window on the screen. Select the device
vou want to connect to and click the Select button.

The NXT that you want to connect to appears in the NXT
window as available. Click the Connect button,
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b = LECO MINDSTORMS NXT

Pair with a Bluatooth Dewvice
Select 2 Bluetsath Dewics and click the Pair buttan.
To find devices in fnge of wour computer 10 pair with, click the Saarch
butian,  your dewice 15 not found make sure IE s “disooverasie” and
search again.
Chow onhy Al Devices e
Clevice Category.  All Categories e I
1 Device %
' f
J i
]
{ Search Again | | Cancel {  Pair ) ﬁ
F,

7 G MINDS TORMS MNXT

Please anter 3 Passkey ©0 Lse with this device

;‘ Fasskays are medquinad 1o gair with o Sleetgdth gewice, The same
passhey must be entered o the device as well as this compater.
Miost devices allow wau to create your awn Passkey, but some
povioes require a fieed one,

RBXT
1334

1 vl Cancel [ oK -:'I

|

Ciscovering Bluetooth Devices .

| Search Again | | Cancel

Banch |
and

Pair ) ﬂ

=

2 [ A |

-

s |
- |
1 |
B
T

4K

- P
Enter the passkey onyour NXT and canfirm the
connection by pushing the orange [Enter] button. IF

vou have chosen the default passkey, just click the
orange [Enter| button,

The Pair with a Bluetooth Device window pops up.
Select the NXT. Click Pair.,

When you connect to a device For the frst time, a Passkey
window will pop up. Enter the passkey to use with this
device [the default passkey is 1234] and click DK,

! et

Your Macintosh and NXT are now connected and can share data.
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BLUETOOTH SUBMENU ON NXT

¥ b _'1” T‘“
| E | N P '
- / E&.‘ /
a0 - - ’
Bluetoath Search
Select the Bluetooth submenu on the
NAT displary.

devices that it can connect to.

-

PR
-_1_,.

My Confacts

Toucan see all of your trusted Bluetooth contacts
in My Contacts. These contacts can automatically
connect and send data to your NXT without using a
passkey. To add a new contact to the list, you must
have been connected to the contact befare. Devices

which you have been connected to, will autamatically
be added fo the listin My Confacts.

a

T
=1

dub
=

ok hidgg

oA

Connections

Search for ather Bluetooth devices. After you have chosen the Search
icon, your NXT will automatically start o search for ather Bluetoaoth

J

——e

This item displays your current connections. You can
connect your NXT to three devices at the same fime
|on Line 1, 2 and 3|, while one device can connect fo
you [on Line 0], Mote, hawever, that while you can
be “connected” to up to three devices, you can only
“‘communicate” with one device at a time.
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IEEEETTEE.
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You can alsoview the connection status in the NXT window in the
soffware. There you can change the name of your NXT, check
battery and memory levels, and delete programs onyour NXT.

Check the connection status in the icon bar at the top of

the NXT's display.
[Fthere is no Bluetooth icon shown, Bluetooth is OFF.

:# Bluetooth is ON but your NXT is not visible
to other Bluetooth devices.

:#{ Bluetooth is ON andyour NXT is visible to
other Bluetooth devices.

:#{:r Bluetooth is ON andyour NXT is connected
to a Bluetooth device.

=) / - /
. . . ‘-'

Visihility Passkey On/OFF

Use the Yisible option to make your NXT The Passkey ensures that only Bluetooth fou can furn Bluetooth Functionality on

visihle or invisible to ofher Bluetooth devices approved by you can connect to or off. IFyou furn Bluetooth off, you will

devices when they doa Bluetooth search. yvour NAT, Whenever you connect foa not be able to send or receive data over
Bluetooth device for the Arst time using Bluetooth. To save battery power, turn
vour NET, youwill be asked fora passkey. off the Bluetooth Function when it is not
Select the preset passkey 1234 or make up in use.
your own code. Other Bluetooth devices
must know your passkey in order to confArm Note! Bluetooth is furned off by default.

a connection with your NXT.
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CONNECTING YOUR NXT TO ANOTHER NXT

P I & | e Al |
~y ) —ay ) r,.

; J : £ : 2
Select the Bluetooth submenu Select the Search icon to search for lepending on how many devices are
on the NXT's display. other Bluetooth devices. Your NXT will detected in the area, a list will popup on

automatically search for Bluetooth the NXT's display after a few seconds.
devices,
4. RN e e
- y | Ll y | €l 5 Y
e M asac dme |
] it L / = /
L ¥ : ¢ L J
Select the device you want fo connect fo. Gelect which of the three lines of communication you want the connection to
Remember that you can give each NXT a he on |1, ¢ or 3. You can connect yvour NXT to three different devices af the

unigue name

— see Naming the NXT on page 11.

T (PROS—— |

|

came time.

IFyou connect to a device For the Rrst time, your NXT will ask fFor
a pasckey. Just press enter to use the default passkey 1234 or
make up your own code. The other Bluetooth device must know
your passkey in arder to confirm the connection. This means
that the fwo NXTs need to to enter the same pasckey in order to
connect.

If you want to connect your NXT fo more than one Bluetooth
device, go to the My Contacts submenu to select a trusted contact
or start a new search.
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Connecting to more than one NXT

You can connect up to three NXTs or other Bluetooth
devices to your NXT at the same time. However, you can
only communicate with one device at a fime.

Sending Rles from NXT to NXT

It's pasy to send programs from your NXT to another NXT:

b

1. ———

w h— E— Y

P
-

h 2 h

v

drt——

Make sure that yvour NXT is connected to Select Send.
the NXT to which yvou want to send the
program |see page 3b, Lonnecting your
NXT to another NXT].

Select the My Files submenu in the NXT's
display and select the program you want

to send.
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Your NXT will now send the Ale.
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Select which of the connected devices you
want the program to be sent to [Line 1, £
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Connecting your NXT to a mobile phone
IFyou have a mohile phone with Bluetooth capahility,
you can use it with your LEGO® MINDSTORMS® NXT set.
Go to www.MINOSTORMS.com/bluetooth for more infor-
mation on mohile phone requirements. Here you can also
download the MINDSTORMS NXT Bluetooth connection
program for your mobile phone and get additional infor-
mation on how fo connect your NXT fo mobile phones.
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SYSTEM REQUIREMENTS

Before installing the LEGO® MINDSTORMS® NXT Software,
you must make sure that your computer meets the

Following minimum system requirements:

Windows

« |ntel® Pentium® processor or compatible,
d00 MHz minimum

» Windows XP Professional or Home Edition
with Service Pack ¢

« ¢56ME of RAM minimum

 Llp to J00ME of available hard disk space

« XGA display [1024x768]

« 1 available LUSE port

« [0-ROM drive

» [ompatible Bluetooth adapter [optional|*

FOWERED BY

/

)

Macintosh

« PowerP(® 63, G4, b5 processor, 600 MHz minimum
« Apple MacO5Xv. 10.3.90r10.4

« ¢56ME of RAM minimum

« pto 300ME of available hard disk space

« XGA display [10£4x768]

« 1 availahle 58 port

« [O-ROM drive

» Lompatihle Bluetooth adapter |optional|*

*Supparted Bluetooth software include Widcomm® Bluetooth for Windows [newer thanv, 1.4.2.10 5P5], and the Bluetooth stacks inclucled
in Microsoft Windows XP |with Service Pack 2| and Apple Mac05 % [10.3.9 and 10.4]. For more details on compatible Bluetooth adapters,

see wWwWw MINOSTORMS.com/bluetonth.

INSTALLING THE SOFTWARE

0

Microsoft Windows

Exit all open programs.

Insert the CO-ROM.

IF the CO-ROM does not run automatically:

- click the Start button |at the hottom left-hand

corner of your screen|
- click Run

- type d\autorun.exe |where d: is your CO drive
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Select your preferred language.
‘ Follow the on-screen instructions.

LEGO® MIMNOSTORMS® MNXT
Saftware v1.0

Neder|ands

English

Francais

Deutsch
AAEE
Exit

mindsTorms

Apple Macintosh

Exit all open programs.
Insert the CO-ROM.

Open the “LEGO MINDSTORMS NXT™ CO-ROM and double-click Install.
Select your preferred language.
Follow the on-screen instructions.

When the installation procedure is complete, click Finish. You are now ready fo use the
LEGO MINOSTORMS NXT Software and create programs for cool robotic inventions.
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YOUR FIRST PROGRAM

MINESTORMS
T

[7]

This simple program will make the NXT play a
sound Ale. It will help you understand how to
connect your computer to the NXT.

Start the software on your PL or Macintosh
by double-clicking the program icon.

Start Mew Program

Type in the name of your Arst program,
or just click on Go!

II"-'1'5,r Firsk Program

Open Recent Progr am

| Go = \

[3 Go > \

: First, click on the Sound block icon in
‘ the programming palette.
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J)

ADownboad and run |I
-

=y

Urag a Sound block and drop it to the right of the
Starting point in the work area.
Your program is now ready to download and run.

Make sure you furn on your NXT and connect the LISB
cable to both your computer and the NXT |see page 8,
Lonnecting the NXT technology].

Locate the Controller in the lower right corner of the
work area. Llick Download and run [the central hut-

fon] and listen to what happens.

Longratulations, you have completed your Arst

program!
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SOFTWARE USER INTERFACE

A quick overview

EEFERT0ES (X € e i [
1. Robo Center & Bote Center

2. My Portal b k R
3. Tool bar Ji | o e %
4. Work area = e p e )| TR -
5. Little help window 2 =5 |

B. Work area map 2)| [ — g =

7. Programming palette " 2

d. Lonhguration panel | =

9. Controller é?mﬁ.c = e

10, NXT window R — T e e )

E LEGO MINDSTORMS HXT

Fle Edt Taok Help ] =

D0 48 Do

| B e

DE2E

Lser Profie: |.:|nﬁu|| !- |

4

Hame =

Robo

Center

vohiclos
* Quickstart

Animals

i \j

':IL_ .. i A

s I Caonreeck [I Remoue l

| . . : Humanoids

E——

e =

d  imicinm L=

i i L5 PO Ca @B M@c S Power: ) —(— | TS Move Block o}

kg ; Uze thiz blods to set gour robob o go forwsrds or backwards i!
i  Drirection L= L= 'E E“; Crurstion: | 1 !Enlalil:n: Il im 3 straight line or to turm by fallowing & curee, Define baow —
L *E _ — far wour rabot will go by using the Duration properes
T 0 A D swenn [c -‘] ¥ (B =] s buat Actiont - ] Brabe O b Coam Maie help #
| :.:D. .\:ﬂi.
T ble & - [ W
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3 -

.

Robo Center window
Here you can And building and programming instructions for four cool models.

My Portal
Here you can access www . MINOSTORMS.com while programming your robots.
You can get more rohotic challenges and download programs, sound effects and other cool stuff,

The tool bar
The tool har includes the most frequently used commands from the menu bar in an easy-to-reach
location.

The work area
This is the space on the screen where programming takes place. Drag programming blocks From the
programming palette to the work area and attach the hlocks to the sequence heam.

Little help window
Hereyou can always get help if needed.

The work area map
lise the pan tool on the tool har fo move around the work area — and use the work area map [tab in the
lower right corner| to get an overview.

The programming palette

The programming palette contains all of the programming blocks you will need to create your
programs. The tabs at the bottom of the palette let you switch between the common palette [containing
the most frequently used blocks|, the complete palette [containing all of the blocks|, and the custom
palefte [confaining blocks that you download or create yourself].

The confguration panel
Each programming block has a configuration panel that lets you customize the block for the specific

input and output that you want.

The Controller
The five buttons on the Confroller let you download programs |or parts of programs] from your
computer to the NXT. With the Lontroller you can also change the settings of your NXT.

The NXT window
This pop-up window will give you information about your NXT's memory and communications settings.
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THE ROBO CENTER

g = [

Robo Center

Vehicles

* Quickstart

&

Machinos :’-,:' E

Animals

m Hame = Yehices

Robo Center

E vehicles
* Qickstart

.--_.- " L +
L TriBOL * Start hora!

e you buld the robot so thet it drives in the exact drections vou sant?

Toull need to buld & tough driving base that can oo forwsards, backwards,
tum Eft, nght or stop.

Start

Programming Guide Ik

In the Robo Center vou will And different robot models
thatyou can build and program to do what you want.

Start by selecting a robot model to build and program.
We recommend that you start with the TriBot as it is a
cantinuation of the Quick Start model included in the hox.

Follow the on-screen building and programming
instructions — or solve the challenge on your own.
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4) Building Guice

Programiming Guice

Can you program wour rabot ko go Formards on the best pad and then
reverse back to the starking poink at a fasker speed?

download it to the NXT and run if.

downloading a program.

Downloadf—

Testyour robot using the challenges provided.

The pragramming palette contains all of the programming
blocks you will need to create your programs. Each
programming hlack determines how your robot acts or
reacts. By comhining hlocks in sequence, you can create
programs that will make your robof come to life.

When you have Anished creating your program,

Remember to turn on and connect your NXT before
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Common palette

To simplify its use, the programming palette has heen
divided into three palette groupings: the common
palette [containing the most used hlocks|, the
complete palette [confaining all of the programming
blocks|, and the custom palette [containing blocks you
download or create yourself].

we recommend that vou to start with the blocks in the
common palette. You should be able to Ainish all of the
starter challenges in the Robo Center with just these blocks.
The software's help area has more information about the rest
of the programming blocks when you are ready to move on.

&7

E

Move block

This block controls the robot's motors and
synchronizes its movements. Use this block to
setyour robot fo go forwards or backwards in
a straight line or to turn by following a curve,

Wait hlock

This block lets your robot sense its environment
for a specific condition before it confinues with the
program. For example, use the Wait block to make

Record/Play hlock

This block lets yvou record a physical
movement with your robot and then play back
the recorded movement elsewhere in the

program. . 4| the robot wait for a specifc sound, touch or time,
before it moves on with the program.

Sound block e Loop block

Lse this block to play a sound Rle orasingle hr‘;?l Use thic block if you wantyour robot to do the

fone. To compose a melody of fones, arrange \ k . same thing again and again. For example, make

several sound hlocks in arow. your robot move Forwards and backwards

J continuously until the Touch Sensor is pressed.

Switch block

This block lets your robot make its own decisions,
such as going left when it hears a loud noise and
going right when it hears a soffer noise.

Display block

Use this block ta display an image, write some
text, or draw a shape on the NXT's display
SCreen.
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THE CONFIGURATION PANEL

Each programming block has a confguration panel that lets you adjust the
settings of the hlock for the specific actions that you want. When a block

s selected in the work area, its configuration panel will be visible at the
hottom of the screen.

By changing the parameters on each configuration panel, you can change
how a particular block will behave. For example, to make your robot move
Faster, you can change the Power property on the Move block's configuration
panel.

- — e

Move § LB Port; 0 A B G A Power: 'J_Q"W_ r
{EJ;__ i Dircion; 0 = O O G F¥ Duration: | 1| [Rotations @l

| 0 % £y Stesting: 1 A Mext Actioni & Bl| Brake O Bl Coast

|':§ . & { " (

THE CONTROLLER

The Ave huttons on the Controller communicate from your computer to the NXT:  The Download and run selected button
downloads and runs just a piece of your
program’s code |e.g. a single hlock or just

The NXT windaw bufton gives YALLAELRES a few blocks|. Select the blocks you want
to the NXT's memory and communications to test and click on the Download and run
- seftings. selected hutton. You will then be ahle to see
=) how the small sequence of your program
performs on the NXT without having fo
download the whole program.
|
= L 3
The Download button downloads the program =) The 5top hutton stops a running program.
to the NXT. You can then run the program
fFrom the NXT. i

The Download and run button
downloads a program to the
NXT and then starts running the
program.
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B LEGO® BRICKS

ELEMENT OVERVIEW

These are the LEGD® bricks in the MINOSTORMS® NXT set #8527,

E
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& LEGO® BRICKS

TEST PAD

Test all your models on this test pad.

- EmindeETorms

&

Q

'

START

|
|

|

=~z This is the starting point on the pad.

TEST PAD 1 BSZ7 g



B LEGO® BRICKS

LABELS

lse these labels to decorate your robots.

-

(«

[JINDS VYLD

SW.JA LSO

©© @ ELIELTT

.

You can use these lahels to stick around
both ends of a cahle, to make sure the
cahle is connected to the right port.
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B USEFUL INFORMATION

TROUBLESHOOTING

Resetting the NXT

IF the running icon stops spinning, your NXT has frozen

and you will need o reset it. Follow these steps to reset your NXT:

Make sure that your NXT is furned on.

Push the reset hutton that is located on the back of
your NXT in the LEGD® Technic hole in the upper left
corner. Use, for example, an unfolded paperclip to

press the button.

IFyou press the reset button for more than 4 seconds
vou will need to update the Armware [see below].

Updating the Armware in the NXT from your computer

Lo to Tools = Update NXT Firmware.
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Make sure that your NAT is turned on.

Note! If you have just reset your NXT [see above|

the display will not show anything. A ficking sound
will tell whether it is turned on or not.

Make sure that your NXT and computer are connected
with the USB cahle.

Go to the Tools pull-down menu in the software's
menu bar and select Update NXT Firmware.



B USEFUL INFORMATION

(Y Uipdate WET Frrmmenre : =l Select the Armware you want to update.
ek i e e LS Click download. [Note! The Windows ‘Found new
D crive Lydaces: — hardware wizard' will pop up the Arst fime you
B Avetatis Frrmor: Fies update your Armware. Lomplete the wizard by
) following the an-screen instruction hefore you
confinue.
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For other types of troubleshooting, go to www.MINOSTORMS.com/support

FCC approval:

The LEGO Group hereby declares that the LEGOE MINOSTORMSE NXT [B5Z7 |

complies with the requirements of the relevant provisions of EU Directive 1999/5/E.
LUnder conditions in which static electricity might occur, the unit might switch itself to
standby mode. The unit may have to be reset by the user.
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Quick Build
schnellbaumodelle
Construction rapide
Costruzione rapida
snel bouwen
Construccion rapida
Byg hurtigt

Nopeaan rakentamiseen
Bygg snablbt
Construcao Rapida
rpfiyopeg Kaovaoweués
Kiserletezdknek

Experienced Build
Kénnermodelle
Construction normale
Costruzione esperta
Bouwen voor gevorderden
Construccion experta

Byg videre

Kokeneelle rakentajalle
Eygg mer

Construcao para Experimentacos
Emdéfiec Kataoxzuio
Haladaknak

EBmndsTorms

Advanced Build
Profimodelle
Construction avancee
Costruzione avanzata
Geavanceerd bouwen
Construccién avanzada

Byg avanceret
Taitavalle rakentajalle
Bygg avancerat
Construcao Avancada
EReAypbves Kataoxsudn
Profiknak
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